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IMPORTANT INFORMATION

Every effort has been made to ensure the accuracy of the product documenlétion in
this manual. However, because Atari Corporation is constantly improving and updating
its computer hardware and software, it is unable to guarantee the accuracy of printed

material after the date of publication and disclaims liability for changes, errors, or
omissions.

Reproduction of all or any portions of this manual is not allowed without the specific
written consent of Atari Corporation.

Atari. the Atari logo, MEGA, Rainbow TOS, SC1224, SM124, ST, Stacy, TOS, and
Trak-Ball are trademarks or registered trademarks of Atari Corporation. GEM and
GEM Desktop are registered trademarks of Digital Research, Inc. MS-DOS is a regis-
tered trademark of Microsoft Corporation.
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INTRODUCTION

The Atari Stacy computers offer the same speed, power, and
dependability of Atari MEGA and ST computers, plus portability.
Stacy adds a built-in display and a built-in Trak-Ball to create an
attractive, compact, and portable laptop.

The Stacy comes equipped with an enhanced version of the Atari
operating system, TOS. The new Rainbow TOS is faster and more
convenient to use. It also adds several features such as the ability
to move files without copying.

The Stacy computer package includes a unique collection of utilities
called Mouse Accelerator Ill. Mouse Accelerator |ll features utilities
that allow you to customize your Stacy working environment by set-
ting Trak-Ball speed and configuring the screen saver.

This addendum is an update to the ST Computer Owner’s Manual.
The Rainbow TOS section describes the operating system enhance-
ments. The Mouse Accelerator Il section provides a detailed descrip-
tion of the Mouse Accelerator Il utilities. The Stacy Computer section
gives a brief description of the hardware that is unique to the Stacy
computers, such as the built-in display, Trak-Ball, and convenient
power adaptor.

RAINBOW TOS

The new Rainbow TOS provides many improvements to your
computer's GEM Desktop operating environment. These changes
increase the computer's operating speed and make your computer
easier to use.

File Selector (formerly Item Selector)

Two important changes affect this dialog box. One is the addition
of the Drive Selector. The other is the improved use of wildcard
characters.



The Drive Selector displays drive identifier letters A through P. Posi-
tion the pointer over a letter and click the mouse button to select
that drive. Drive identifiers representing uninstalled drives appear in
a light typeface and cannot be selected.

Wildcard characters allow you to more easily control the Directory
window display. Use wildcard characters to replace portions of the
file extension section of a pathname on the Directory Line.

For example, if DASALES\*.DOC appears on the Directory Line,
only files with the .DOC extension will display in the Directory win-
dow. To display the entire contents of the subdirectory SALES
delete .DOC and replace it with the asterisk wildcard character.
Refer to your computer owner's manual for further instructions on
using wildcard characters.

To display the new directory, press [Return].

Move Files

With Rainbow TOS you can move a file from one folder or drive to
another without creating a copy of the file.

First, select the file(s) you wish to move. Then hold down [Control]
as you click on and drag the selected file(s) to a new location. Dur-
ing the move process, a Move File(s) dialog box displays the number
of files being moved.

As each file is moved, the Move File(s) dialog box displays the file's
name and complete destination (disk or logical drive letter and
folder name).

When you copy or move files, Rainbow TOS does not change the
date and time stamp of those files. File date and time information
will only be updated when the file is changed.



Skip a Single File

During Group Copying
The option to skip a single file during a group copy procedure
becomes available when a filename conflict occurs. A filename con-

flict occurs when a file is copied from one location to another and a
file with the same filename already exists at the new location.

The following three options are presented when a name conflict
occurs:

Copy Rainbow TOS overwrites the existing file and
the copy operation continues.

Skip Rainbow TOS does not overwrite the file.
Continues with the copy operation.

Quit Rainbow TOS does not overwrite the file.
Ends the copy operation.

Abort Group Copy, Move,
and Delete Operations
You can abort the copy, move, and delete operations performed by

Rainbow TOS. Press and hold down [Undo]. A dialog box displays,
giving you the choice of continuing or ending the operation.

MS-DOS

Disks formatted with Rainbow TOS are fully MS-DOS compatible.

Install Application

The Install Application option of the Options menu allows you to add
one of two convenient features to any GEM based application
program.



Install Application allows you to change the status of any application
from normal status (application must be loaded from the desktop) to
autoboot status. If an application is set to autoboot, the application
will automatically load whenever your computer is switched on. You
can select any application with PRG, .APP, . TTP, or .TOS extensions.

You can also install an application to automatically load whenever
you open a data file with the chosen file extension. Some applica-
tions can open from a desktop data file only if the data file resides in
the same folder as the application program files. Check the docu-
mentation supplied with the application for more information.

Follow these instructions to enable an application to load directly
from a data file, or to change the boot status of an application.

1. Select a program file ( TOS, .APP, .TTP, .PRG) from a directory
window.

Select Install Application from the Options menu. The Install ‘
Application dialog box appears, listing the application program
file you selected from the desktop.

2. To install the application to run from a data file, enter a data file
extension in the Document Type field. Enter the most common
extension of files that use the application. (Consult the manual
supplied with the application for the most common file extensior..)

3. To change the boot status, select Auto to autoboot an applica-
tion, or Normal to start an application from the desktop.

4. Select an application type. Your choices are GEM, TOS, and
TOS-takes parameters.

Most programs that run from the desktop have the extension
.PRG or .APP. Both of these extensions indicate a GEM applica-
tion. However, some applications have the extension .TOS or
.TTP. The extension .TOS indicates a TOS application. The
extension .TTP indicates a TOS-takes parameters application.

@ Note: To use a .TTP application first select the application. Then
enter the required parameters when the dialog box appears.



5. Select OK.

6. To save the application’s new status, select Save Desktop from
the Options menu.

Disk Copy/Format Dialog Box

Rainbow TOS uses a new combined dialog box for copy and format
operations. This box displays when you select either the Format option
from the File menu, or drag a disk icon on top of another disk icon.

Select Copy or Format from the Copy/Format dialog box. Select
from the available options and click on OK. The bar graphs in the
lower half of the screen graphically detail the copying or formatting
that occurs.

Changing a Folder’s Name

With Rainbow TOS you can change the name of a folder. Click on a
folder and select the Show Info option from the File menu. The Folder
Information dialog box displays. You can now type in a new name
for that folder.

Keyboard Reset

You can reset your computer from the keyboard. Hold down [Controll
and [Alternate], then press [Delete]. This key combination causes the
Stacy to warmboot.

Pressing [Control] [Alternate] [Right Shift] [Delete] causes the Stacy
to coldboot. This coldboot clears all reset-resident RAMdisks and
other data and variables that are cleared by a cold boot but not by a
warm boot.



MOUSE ACCELERATOR I

The Mouse Accelerator Il program features utilities such as the
Backlight/Screen utility that allows you to configure the Stacy’s
display, and the Mouse Accelerator that allows you to set Trak-Ball
speed.

Mouse Accelerator ///
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Backlight/Screen Control
———Stacy Box
Mouse Accelerator

Modem Recognition
Automatic Parking

Configuration

Even though they were designed for the Stacy, the Mouse Accel-
erator llI utilities can be used with any MEGA or ST computer. If
you are using the Mouse Accelerator |l utilities with the Stacy,
position the pointer over the Stacy box. Click once to highlight the
word Stacy. Remove the highlighting if you are using the Mouse
Accelerator [l utilities with a computer other than the Stacy.

Mouse Accelerator

The Mouse Accelerator allows you to increase the speed at which
your cursor responds to the movement of the Trak-Ball. If you wish
to accelerate the cursor response speed, choose the top arrow cur-
sor (high acceleration) or the middle arrow cursor (low accelera-
tion). For a normal (non-accelerated) setting, choose the bottom
arrow cursor.



Backlight/Screen

The Backlight/Screen control is a screen saver utility that protects
the Stacy screen from image burn-in. You can choose the type of
screen saver you wish, a full screen shut-off (the computer icon) or
a backlight only shut-off (the light bulb icon). To choose the type of
screen saver you wish, position the cursor over the desired icon
and click the Trak-Ball button. The chosen icon highlights.

If you do not touch a key or move the cursor, the screen saver
operates automatically after a set period of time. Use the timer to
choose the period of inactivity (in minutes) that must pass before
the screen saver operates.

To set the timer, position the cursor over the numbered box (slider).
Drag the slider to the right or left until the number of minutes you
desire highlights within the box. Release the slider. Another way to
move the slider is to position the cursor over one of the clock icons
and hold down the Trak-Ball button. The slider moves in the direc-
tion of the icon until you release the Trak-Ball button.

o Note: You can use the brightness control knob on the Stacy’s lid to

adjust the intensity of backlighting. Turn the knob counter-clockwise

to decrease the amount of backlighting, or completely switch off the
backlighting by turning the knob until you hear a click.

Modem Recognition

If you highlight the Modem Recognition box, the Stacy will recognize
data received via modem as activity and the screen saver utility will
not darken the screen during reception. If you do not highlight the
Modem Recognition box, the screen saver utility does not recognize
the data reception as activity. The screen and/or backlights switch
off after the selected amount of time has passed.



Automatic Parking

The Automatic Parking utility parks the Stacy’s hard disk heads
(moves the read/write heads away from the disk to protect the
disk’s contents) when you are away from the computer. Set the
Automatic Parking utility to operate after a set period of inactivity.
Use the timer to choose the period of inactivity (in minutes) that
must pass before the utility operates.

To use the Automatic Parking utility, highlight the automobile icon.
Set the timer by positioning the cursor over the numbered box
(slider). Drag the slider to the right or left until the number of min-
utes you desire highlights within the box. Release the slider. Another
way to move the slider is to position the cursor over one of the clock
icons and hold down the Trak-Ball button. The slider moves in the
direction of-the icon until you release the Trak-Ball button.

Configuration

After you select a new configuration (Mouse Accelerator ||| settings),
you can use the Configuration boxes to use the new settings for the
present session (select OK). You can also save the configuration to
the disk (select SAVE), or cancel the present configuration settings

and restore the most recently saved configuration (select CANCEL).

THE STACY COMPUTER

The Stacy has ports for connecting external devices such as a
monitor, hard disk drive, or mouse. But the Stacy's built-in display
and Trak-Ball allow you to take advantage of the convenient
portability of this excellent laptop computer. This section describes
the Stacy’s unique hardware.



Display

The Stacy's built-in display is a flat, high-resolution (640 x 400),
liquid crystal display (LCD) with backlighting. You can adjust the
LCD's brightness and contrast with the screen display control
knobs. The volume control knob allows you to raise or lower the
Stacy's volume.

The brightness control knob adjusts backlighting only. Turn the
knob counterclockwise to decrease the amount of backlighting, or
completely switch off the backlighting by turning the knob until you
hear a click. Switching off the backlighting protects the screen from
image burn-in.

The Stacy also has a monitor port on the back of the computer that
allows you to connect an external monitor. You can connect an
Atari SM124 high-resolution monochrome monitor or an Atari
SC1224 RGB color monitor to the Stacy. When you connect an
external monitor, both the external monitor and LCD screen display
the same image.

Trak-Ball

o

The Trak-Ball can do everything a mouse can do. Rolling the Trak-
Ball moves the pointer on the screen. Clicking the Trak-Ball button
is equivalent to clicking the mouse button.

Note: A switch on the right side panel allows you to switch between
the Trak-Ball and a connected external mouse. Move the switch
forward (T-ball setting) to use the Trak-Ball or back (Mouse/Joy
setting) to use a mouse. Connect the mouse to the Mouse/Joy
controller port on the Stacy's right side panel.

Positioning the Pointer

When you roll the Trak-Ball with your finger or the palm of your
hand, the computer detects the ball’'s motion (direction, distance,
and speed) and moves the pointer on the screen in the same way.
By rolling the Trak-Ball, you can position the pointer anywhere on
the desktop.




Clicking

Clicking is an operation used to select an action or menu option, or
open a window, folder, or file. For most actions you will click the left
button above the Trak-Ball. Double-clicking combines two single-
click actions in quick succession. Double-clicking the left button
selects and opens files.

Dragging

To drag, first place the pointer on the icon, folder, or file. Then press
and hold down the left Trak-Ball button. The icon, folder, or file high-
lights, and sometimes a ghost outline appears. While holding down
the Trak-Ball button, roll the Trak-Ball to move the pointer across
the desktop. The ghost outline moves with the pointer. When you
release the button, the icon, folder, or file jumps to its new location,
appearing at the last position of the ghost outline.

Case

Lid

The Stacy case has many features that combine to create an easy
and convenient portable working environment. This section describes
the various features on the Stacy’s lid, and back and side panels.

The lid contains the flat liquid crystal display (LCD) screen. It also
contains the display’s brightness and contrast controls, a speaker
and volume control, disk drive and battery indicator lights, and a
clamp.

" Position the computer on a level surface with its carrying handle

folded flush with the bottom of the unit. To release the lid, slide the
two release buttons on the front of the unit outward with your
thumbs. Raise the lid.

10




Positioning the Stacy

To adjust the angle of the unit, open the port cover that extends the
full length of the back of the unit. Raise the back of the unit and
push down on both cover release tabs. Swing the port cover down
to support the unit.

Port Covers

Port covers on the Stacy’s back and side panels protect the
computer's switches and ports (hard disk drive port, printer port,
etc.). To remove any side panel port cover, press in on the cover
grip and slide the cover down. (See Positioning the Stacy for
instructions on how to open the back panel port cover.)

Power Adaptor

The Stacy comes with a power adaptor to provide an adequate
power supply for the Stacy computers. Connect the power adaptor
jack to the power port on the rear panel of the Stacy. Insert the two-
pronged end of the power adaptor cord into a standard AC outlet.
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